


• MS PowerPoint is a program that is included in the 
Microsoft Office suite. It is used to make presentations 
for personal and professional purposes.

• Microsoft PowerPoint is a powerful presentation 
software developed by Microsoft. It is a standard 
component of the company's Microsoft Office suite 
software, and is bundled together with Word, Excel 
and other Office productivity tools.

• Microsoft PowerPoint is a software application that is 
particularly used to present data and information by 
using text, diagrams with animation, images, and 
transitional effects, etc in the form of slides. It helps 
people to better understand the idea or topic in front 
of the audience practically and easily.



Use of MS Power Point :

1. Power Point in education

• Teachers can use PowerPoint to teach subjects lessons and 
chapters of any book.

• It gives the opportunity to the teacher to cover a topic in the 
different t slides. And in each slide, they can manage, 
highlight, mention, and teach important points that are 
essential to cover on that topic. 

• On the contrary, students can create their own presentations 
for self-learning or can create for teachers to show them.

2. PowerPoint in business:

• PowerPoint helps people in business to create a plan, 
structure related to the business or organization. 

• In the case of the training team, you create and showcase the 
methods with the help of diagrams, images, and circles.



3. PowerPoint for job seekers

• Through PowerPoint, job seekers can create digital 
resumes or multimedia resumes and it will become 
a unique way of presenting skills and knowledge in 
front of interviewers.

4. Use PowerPoint to Make Tutorials

• For the purpose of training or educational 
contexts, PowerPoint can be easily used to create 
worksheets and tutorials. 

5. Use PowerPoint as a Photo Slide Show

• By using PowerPoint, you can create photo slide 
shows or digital album for personal promotional 
uses. For instance, you can create a touching 
tribute to your family members.



1. Slides : Slides are the individual pages of your presentation. Slides 
can have titles, text, graphs, drawn object, shapes, ClipArt, drawn 
art etc.

2. Handouts : These are the printed copies of our presentations. They 
can be one per page or reduced.

You can also print your slides as handouts with two, three, four, six 
or nine slides on a page that your audience can use for future 
reference.

3.    Speaker’s Notes : These provide the presenter with a page which 
corresponds to each slide and contain a small image of the slide 
along with additional notes. These are the reminder notes.

4. Objects : These are the individual elements which make up the 
presentation. These objects can be text, clipart, pictures, charts or 
other types of graphics .

5. Place holder : These let us to quickly add the type of element we 
are likely to put in a particular portion of the slide.





The ribbon consists three areas :
1. Tabs : theses are at the top of the ribbon eg : Home, 

Design, Animations etc.
2. Groups : Each tab has its own set of groups – eg : The 

home tab contains the Clipboard slides, Font, 
Paragraphs, Drawing and editing group etc.

3. Commands : These are the buttons, Boxes or menus 
relative to each group for eg : the alignment and bullets 
and numbering, buttons are in paragraph group. While 
find and replace are in editing group.



Figure : Office button



• New: To create a new presentation

• Open: To open an existing presentation

• Save: To save changes made in the open 
presentation

• Save As: To save the presentation with a specific 
name to a preferred location in the computer

• Print: To print the hard copy of the open 
presentation

• Prepare: To prepare the presentation for distribution

• Send: To send the copy of the presentation to others

• Publish: To distribute the presentation to others

• Close: To close the open presentation



STEPS : 

Step1: Open Microsoft Power point. 

Step2: Go to File at the top of the screen and 
click New. A box that says “Blank/New 
Presentation” should appear on the right side 
of your screen. 

Step 3: Slide Title/ Subtitle Give any title and 
subtitle to your ppt on slide1.



Step 4: As per your choice apply different formatting options to 
format the text and pictures.

Step 5: Add new slide by clicking on new slide on formatting bar or by 
right clicking and selecting new slide option.



Step 1 : click on the office button

Step 2 : click on the save button

Step 3 : the following dialog box will appear.

Step 4 : Give the name to your presentation.

Step 5 : click on OK Button

Figure : Step 1, 2

Figure : Step 3,4,5



• pptx file extension is a Microsoft 
PowerPoint Open XML (PPTX) file created by 
Microsoft PowerPoint.

Steps for opening the Presentation :

STEPS : 

Step1: Open Microsoft Power point. 

Step2: Go to File at the top of the screen and 
click Open. A box that says “Select the folder” 
should appear on the right side of your 
screen. 

Step 3: Select the folder than click on “Open”.



Figure : Click on Open Figure : Select the folder than click on Open



In PowerPoint, you can print your slides, your 
speaker notes.

Print your presentation :

• Select File > Print.

• For Printer, select the printer you want to 
print to.

• Choose a print layout: Under Settings,Click on 
Print then click on “Print Preview” then click 
on “Handouts”.

• From handouts select how many slides you 
want in one page.



Example : Here we select 2 Slides Per page



1.New Slide -

• Click this button to insert a new slide into the 
presentation. 

• The slide will be inserted after the current slide with 
the same format as the current slide. 

• Clicking the arrow will display a gallery of different 
slide layouts. Click any of the slide layouts to insert a 
new slide into the presentation.



Figure : Adding New Slide



2. Layouts :

• Layout When this button is clicked, a gallery of 
different slide layouts will appear. 

• Click one of the layouts to apply it to the current 
slide; the slide where the insertion point is located.

Figure : Different Layout Designs



3. Reset : 

• This button is used to reset the slide position, 
size, and formatting to its default value.

• Reset the position, size and formatting of the 
slide placeholders to their default settings.

4. Delete :

• Removes the slides currently selected.



1. Text Direction :
• To change the orientation of text to vertical or stacked, click 

this button. 

• It is also possible to rotate the text using this button.



2. Align Text :

This button is used to specify 
how text is aligned vertically in 
the text box. The default 
options are top, bottom, and 
middle.

3. Convert to SmartArt :
• Convert text to the smart 

graphic to visually communicate 
information.

• Smart Graphics range from 
graphical lists and process 
diagram to more complex 
graphics, such as Venn diagram 
and organization charts.

Figure : Align text

Figure : Convert to Smart Art



• Drawing
This area allows you to draw shapes, arrange them, 
and style them:

• On the left there are Autoshapes, starting 
with Recently Used Shapes. This can include a Text 
Box, which is counted as a Basic Shape. 

• Notice that there are three buttons on the right side 
of the Autoshapes box. The top two will scroll up and 
down the list of different shape types. The bottom 
button will show the whole list of shapes.



Figure : Different types of available shapes



• Next, you can arrange the 
Shapes

• Choose Quick Styles ("presets") 
for decorating the shapes:

• And then, finally, on the far 
right, you can use one of the 
three buttons for:

• Shape Fill: choose a fill color 
(background color) for a shape;

• Shape Outline: choose a color 
and style for the shape's outline

• Shape Effects: choose between 
the many special and 3-D 
effects: Shadow, Reflection, 
Glow, Soft edges, Bevel, or 3-D 
Rotation. There are also presets 
for you to choose from.

Figure : Arrange Shapes

Figure : Quick Styles



Introduction :

• The second tab in the Ribbon is 
the Insert tab. This contains the basic set 
of Objects which you can insert into a slide.

• The Insert Tab is used to insert different 
features such as tables, pictures, clip art, 
shapes, charts, page numbers, word art, or 
headers, and footers into a presentation



1. Tables :

• This button is used to insert a table into a slide. A list will 
appear with a grid that can be used to create the table.

• Additional options for creating a table, such as drawing a 
table, are also listed.

• If you click on the Tables button, this menu will appear:

Figure : Inserting table



• You can select the number of columns and rows by 
dragging the mouse over the grid. Notice that while 
you drag the mouse, the table dynamically draws 
itself in the slide, giving you a preview of what the 
table will look like when you decide on a size:



1. Picture : Pictures To insert a picture from a file into 
the document, click this button. The Insert Picture 
dialog box will appear. This dialog box is used to 
select the picture.



2. Clip Art : Displays the Clip Art Task Pane.

To use clip art’s gallery , Follow these steps:

❑ Select desired slide.

❑Click on “Insert menu”. A Ribbon is open.

❑ Point to the “Clip Art” Command in the 
illustrations group.

❑Click on clip art Option .”Insert clip art ” 
dialog box will appear.

❑ Search the clip art that you want to 
insert and click on the image of the clip 
art .

.
Figure : Clip Art



3. Photo Album : To create a presentation based on a 
set of pictures, click this button. Options can be set 
for how the pictures display on the slide. Also, 
captions may be added to each picture

Steps : 
•Click on insert tab.
•Click on “Photo album” Present in In illustration Group, The 
drop down will appear.
•Click on New Photo album.
•The dialog box will appear for selecting and inserting the 
images.
•Then click on create button.



Figure : Inserting the Picture

Figure : Selecting the image



4. Shapes: 

• add any of more than 100 pre-made 
shapes.

• This button is used to insert different 
shapes into a slide. 

• A gallery of different kinds of shapes 
will appear when the button is 
clicked. To insert a shape, click the 
desired shape and then draw the 
shape in the slide..

Figure : different Shapes



5. Smart Art  : 

• To insert a Smart Art graphic into a slide, click this button. 
Smart Art graphics are objects such as Venn diagrams and 
organizational charts. 

• When the button is clicked, a gallery of different categories 
and shapes will be display.

• SmartArt is a system which allows you to quickly crate visual 
charts. Click on this, and you get a dialog box:

Figure : Choosing the SmartArt Graphic



6. Chart :

• Click this button to display the Insert Chart dialog 
box. This will display a gallery of different types of 
charts that can be created in a Power Point 
Presentation.

Figure : Inserting the chart



How to Insert Chart :

• Select the Insert tab

• In Illustrations group click on Chart command

• An Insert Chart dialogue box appears

• Select the desired Chart style and click Ok

• Chart will be added to slide and an Excel worksheet 
appears on right side of the slide



How to Enter Chart Data :

• We can't enter data directly in charts. To enter data in chart we 
have to type it in excel spreadsheet that appears when you add 
Chart or click Edit Chart option.

• The data that you enter in spreadsheet automatically appears 
in the Chart. Select the cell of spreadsheet and type the data it 
will appear in the slide. Repeat the process to enter the entire 
data.



1. Hyperlink : 

• With the help of this option, we can link any other 
file in our file. Which will open when clicked with the 
mouse during the slide show.

• To insert a link to items such as a Web page, another 
document, or an email address, click this button. The 
Hyperlink dialog box will display where the link can 
be specified. It is also possible to create a new 
document, worksheet, or presentation while creating 
a link to the item 



Steps To create a hyperlink : 

• Enter some text which you want to make hyperlink.

• Select the text and then click on “Hyperlink button” 
in Links Group. The dialog box will appear.

• Select the file that you want to attach. and then click 
on “OK”. 

Figure : Selecting the file to attach in hyperlink



2. Action : 

• When some type of actions such as 
creating a hyperlink to an object or 
inserting a sound is to be specified, 
click this button. 

• The Action Settings dialog box will 
appear. In this dialog box, it is possible 
to create hyperlinks to other files, 
other PowerPoint presentations, to 
the first or last slide in the 
presentation, or too many other areas. 

• It is also possible to apply a sound to 
the selected object.

• With this option, you select a shape 
and apply the action to the shape that 
the action shows during the slide show 
such as next slide, previous slide, end 
show, etc.

Figure : Setting the action of the object 



1. Text Box :

• Inserts a textbox that can be positioned 
anywhere on the page.

• Text boxes are used to highlight text within a 
presentation. 

• With this option, a box can be created in the 
slide in which text can be written.

Figure :Inserting text box



2. Word Art :

• Insert decorative text in your Document.

• The drop-down gives you a choice of Word Art styles to insert.

• When the button is clicked, a gallery of Word Art styles will be 
displayed. Click one of the styles to apply it to the Text.

Figure : Word Art Styles



3. Object :

• Use this button to insert an object such as an Excel 
Worksheet or an Excel Chart into the presentation.

• By this option we can add other program's file like 
Word, Excel, PowerPoint, Photoshop etc. Or we can 
Insert already created file of other program then MS 
PowerPoint.

Figure : Selecting the Object 



Introduction : 
❑This tab is used to apply a design to a PowerPoint 
presentation.
❑It is also possible to make changes to the slide 
size, slide background, and other design attributes.



1. Page Setup : 

• This allows you to change basic page elements including slide sizes, 
orientation, and slide numbering.

• It also Provides the features of changing the height and width of the 
slide.

• Click on the Page Setup command the following dialog box will 
appear for all the settings :

Figure : Page Setup



2. Slide Orientation :

• The second button simply allows you to change the 
slide orientation quickly--from horizontal to vertical 
("landscape" to "portrait").

Figure : Slide Orientation



• Here you can choose the overall appearance for your entire slide show.

• Themes are an easy way to design a whole slide show. Every slide in the 
presentation will change to match the background, font, colors, and effects 
chosen for each theme.

• The good point about themes is that they are easy and quick and make your 
presentation look nice.

• Move the mouse pointer over each of the designs to see a Live Preview. Click 
the design to apply it to the presentation. 

• To access additional themes, click the arrows at the end of the Styles Gallery. 
To display all the designs, click the More button in the lower right corner of 
the gallery.



• Clicking on "Background styles" lets you choose 
quickly from the styles below:

• If you click on "Format Background," you can choose 
far more detail about the slide background.

Figure : Different Background Styles



Introduction : 
• Animation can help make a PowerPoint presentation 

more dynamic, and help make information more 
memorable.

• This tab can be used to set animations for the 
PowerPoint presentation. Animations determine how 
the bullets, pictures, images, and other objects will 
enter the slide during a presentation. 



• There are several animation effects you 
can choose from, and they are organized 
into four types.

• Steps :

i) In Normal view, display the slide that has 
the text or objects we want to animate.

ii) Select  the object we want to animate.

iii) On the slide show menu , click custom 
animations.

iv) It Gives us various option present in add 
effect button.

v) Choose the effect from the drop down 
that you want.

Figure : Custom Animations



1. Entrance: These control how the object enters the slide. For 
example, with the Bounce animation the object will "fall" 
onto the slide and then bounce several times.

Figure : Types of animations

Figure : Entrance Effects



2. Emphasis: These animations occur while the object is on the 
slide, often triggered by a mouse click. For example, you can 
set an object to spin when you click the mouse.

3. Exit: These control how the object exits the slide. For example, 
with the Fade animation the object will simply fade away.

Figure : Emphasis Effects

Figure : Exit Effects 



Add transition between slides :

• Select the slide to which you want to apply the effect

• Select the Animation tab

• In Transition to This Slide group you will see the 
transition effects

• Click the drop-down arrow to see menu of transition 
effects

• Select the desired transition effect

• Click Apply To All to apply the effect to all slides



Figure : Different Slide transition



ii) Setting transition speed and sound :

How to Set Slide Transition Sound

• Select the slide to which you want to add the transition sound

• Select the Animation tab

• In Transition to This Slide group click the drop-down arrow 
next to Transition Sound option

• A list of different transition sounds appears

• Select the desired transition sound

• Click Apply To All to apply the effect to all slides



How to Set Slide Transition Speed :

• Select the slide

• Select the Animation tab

• In Transition to This Slide group click the drop-down arrow 
next to Transition Speed option

• It will display three options for transition speed

• Select the desired transition speed

• Click Apply To All to apply the same transition speed to all 
slides



• Select the slide
• Select the Animations tab
• In Transition to This Slide group locate the Advance 

Slide section
• It shows two options; On Mouse Click and 

Automatically After
• Enter the desired time for the selected slide in 

Automatically After option
• Select the next slide and choose the desired time
• Click Apply To All If you want to apply the same timing 

to all slides



• This tab provides options for presenting the 
Slide Show to the audience. Narration for the 
show can be recorded. 

• Decisions can be made as to where to start 
the presentation. In addition, custom shows 
can be created.

• This contains tools that control how the slide 
show is presented.



i) From Beginning (F5) : Click this button to start the slide 
show at the first slide. This will start the show at the 
beginning.

ii) From Current Slide (Shift+F5) : This option is used to start 
the presentation from the active slide in the slideshow.

iii) Custom Slide Show : Using this option we can select 
some slides from the presentation and run it 
separately. Using this option, we select the desired slide 
from the presentation and make a set and save it by 
giving a name. Which can be run separately.



i) Set Up Slide Show : In this option, we do some setup related to slides 
such as which slide to show form the presentation - Like All, some 
special series or custom slides.

ii) Hide Slide : With this option we hide the active slide. ie the hidden 
slide will not be visible in the slideshow.

iii) Record Narration : To record a narration to go with the slides in the 
presentation, click this button. The Record Narration dialog box will 
display where the options for recording can be set

iv) Rehearse Timings : On clicking this option, the timer runs along with 
the slideshow, after the slideshow finished, it tells how much time the 
presentation has been taken. So you can rehearse with the 
presentation from the timer.

v) Use Rehearsed Timings :Click the check box for this option if the 
timings that were set up will be used during the presentation.



• When working with PowerPoint, this tab is 
used to view the presentation in different 
formats, it is also used to view more than one 
PowerPoint window at a time, or to decide 
whether to display the ruler within the 
window.



i) Normal : Display the presentation in the normal working 
view. This is the default view for all PowerPoint 
presentations. In this view, the slide pane and thumbnails of 
the slides will be displayed.

ii) Slide Sorter :It is used to easily Rearrange the slide. To view 
the slides as thumbnails, click this button. The slides will 
appear in columns and rows. This format makes it easy to 
rearrange the slides.

iii) Notes Page : Display the presentation in notes view for 
editing the speaker notes. This view focuses on the Notes 
area. 

iv)   Slide Show : This starts the slide show.



v) Slide Master : Displays the slide master letting 
you change the design and layout of the master 
slides. When you open the Slide Master, it will 
show you a slide with many pre-set text and 
media placeholders. These are intended to make 
it easier for you to add a commonly-used slide 
element or style.

vi) Handout Master : Open handout master view to 
change the design and layout of Printed 
handouts.

vii) Notes Master : This button is used to change 
the way the notes page is displayed and printed.



i) Color : To view the presentation in color, 
choose this option. This is the default option 
for viewing presentations.

ii) Grayscale : This button is used to view the 
presentation in grayscale. Gray-scale shows 
the presentation in black and white with gray 
tones.

iii) Pure Black and White : When this option is 
chosen, the presentation will be shown in 
black and white without any gray tones.



i) New Window : To open a new PowerPoint window, click this 
button. A new window will open with the same 
presentation. The presentation will have a number after the 
name.

ii) Arrange All : Click this button to tile the open windows on 
the screen side-by-side.

iii) Cascade : Use this button to tile the open windows so that 
they overlap vertically on the screen.

iv) Move Split : This option is used to move the splitters that 
separate the different sections of the window.

v) Switch Windows : Click this button to switch from one 
window to another window. A list of the open windows will 
display when the button is clicked.


